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• 23.5—31.5 GHz Low Noise and Driver Amplifier

• 24 dB Small-Signal Gain

• 2.4 dB Typical Noise Figure

• 15 dBm Typical Output P1dB

• Internally Matched to 50 Ω

• +3.3 V, 40 mA Nominal Bias

• 16 Lead QFN, 2.5 mm × 2.5 mm

ARF1201Q2 is a low noise and driver amplifier designed for high data-rate applications. With 24 dB of linear gain, 
2.4 dB noise figure, 15 dBm output P1dB and low-current operation, it is well suited to demanding, high-order 
modulation schemes such as millimeter-wave 5G. The circuit draws 40 mA from a 3.3 V DC supply. The part is 
internally matched to 50 Ω with ESD protection. The part has internal bias regulation controlled by VBIAS, or 
alternatively by a resistor between VDD and VBIAS.

The part is RoHS* compliant and built with the latest manufacturing techniques for reliability and quality control.

Export from The Netherlands/EU, no licence.

Description

Functional Diagram

Applications
• 5G Networks

• Point-to-Point Radios

• VSAT

• ISM

All not connected (N/C) pins should be 
connected to RF and thermal ground.

*RoHS compliant — European Union Directive 2011/65/EU 

Pin Pin Name Description

2 RFIN RF Input

5 VBIAS
Current Control & Power 

Down

8 VDD Power Supply

11 RFOUT RF Output

1, 3, 7, 10, 12, 
14, Paddle

GND Ground

4, 6, 9, 13, 15, 
16

N/C Unconnected Pins.

Features

Please refer to 
Datasheet Design 
Guidelines for 
preferred 
features and 
applications

File->Info->Document Title
Don’t Change “Altum RF Datasheet”

Change 
“ARFxxxQy” in 
master slide to 
appropriate part 
number

Leave the orange 
notes. They won’t 
be exported but 
gives other users 
prompts for 
editing

https://www.altumrf.com/
https://hn5aaa387ecdd0c.sharepoint.com/:w:/r/sites/Quality/Quality%20Documents/Guidelines/Datasheet%20Design%20Guidelines.docx?d=wabb08055aaba41549cbd8e1be3e70af8&csf=1&web=1&e=Xus3zP
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Parameter Test Conditions Min Typ Max Units

Frequency Range 23.5 31.5 GHz

Small-Signal Gain

24 GHz
26 GHz
28 GHz
31 GHz

22.0

23.0

21.5

19.0

24.0

25.0

24.0

21.0

26.0

27.0

26.5

23.0

dB

Gain Variation over Temperature 0.02 dB/ºC

Noise Figure

24 GHz
26 GHz
28 GHz
31 GHz

2.7
2.4
2.4
2.4

dB

Input Return Loss

24 GHz
26 GHz
28 GHz
31 GHz

8.0
12.0
9.5

12.0

dB

Output Return Loss

24 GHz
26 GHz
28 GHz
31 GHz

12
34
15
15

dB

Reverse Isolation

24 GHz
26 GHz
28 GHz
31 GHz

46
44
39
35

dB

Output P1dB

24 GHz
26 GHz
28 GHz
31 GHz

15
15
15
14

dBm

OIP3

24 GHz, POUT/tone = +5 dBm, ΔF = 10 MHz
26 GHz, POUT/tone = +5 dBm, ΔF = 10 MHz
28 GHz, POUT/tone = +5 dBm, ΔF = 10 MHz
31 GHz, POUT/tone = +5 dBm, ΔF = 10 MHz

26.5
26
26

24.5

dBm

VDD Voltage 3.0 3.3 4 V

IDD Current
Nominal Bias 35 40 45 mA

VBIAS = 4.0 V, VDD = 4.0 V 80 85 90 mA

VBIAS Voltage
Nominal Bias 2.5 V

Operating Range 0 4.0 V

IBIAS Current Nominal Bias 0.9 mA

1. Parameters tested at 25ºC in laboratory environment with standard 50 Ω matched equipment.
2. Nominal bias of VDD = 3.3 V and VBIAS = 2.5 V (IDD ≈ 40 mA typical).

Return loss for <50 GHz 
should be de-embedded. 
If greater than 50 GHz 
add additional subscript 
note for “Reference plane 
for the return loss is to 
the RF connectors of 
evaluation board”

Electrical Specifications1,2

https://www.altumrf.com/
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Parameter Conditions Min Max Units

VDD Voltage 0 4.4 V

IDD Current 0 100 mA

VBIAS Voltage 0 4.4 V

Total Dissipated Power 0.5 W

Maximum RF Input Power Peak Power +10 dBm

Channel Temperature +175 ºC

Operating Temperature Range -40 +85 ºC

Storage Temperature Range -50 +125 ºC

Moisture Sensitivity Level IPC/JEDEC J-STD-020E MSL1

ESD Human Body Model (HBM) JEDEC JS-001-2023 Class 1B

ESD Charged Device Model (CDM) JEDEC JS-002-2022 Class C3

Thermal and Reliability Data

Stresses at or above those listed under Absolute Maximum Ratings may cause permanent damage to the product. 
This is a stress rating only; functional operation of the product at these or any other conditions above those 
indicated in the operational section of this specification is not implied. Operation beyond the maximum operating 
conditions for extended periods may affect product reliability.

ESD Sensitive Device

These devices are ESD sensitive. Proper handling for assembly and use must be maintained at all times. Please see 
JEDEC JESD625B for further information. 

3. All thermal and reliability data is measured or simulated with 85ºC at the package base, solder junction.
4. Thermal resistance is the difference between the package base (solder junction) temperature and the channel 

temperature, divided by the DC power consumption.

Delete as 
appropriate

Refer to Datasheet Design Guidelines for Absolute 
Max Ratings per process 

CDM not required for die

Absolute Maximum Ratings

Parameter Conditions2,3 Value Units

Thermal Resistance (RTH)4 VDD = 3.3 V, IDD = 40 mA, Small Signal RF 210.6 ºC/W

Channel Temperature (TCH) VDD = 3.3 V, IDD = 40 mA, Small Signal RF 112.8 ºC

Mean Time To Failure (MTTF) VDD = 3.3 V, IDD = 40 mA, Small Signal  RF > 107 Hours

https://www.altumrf.com/
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Nominal Bias: VDD = 3.3 V, VBIAS = 2.5 V (IDD ≈ 40 mA)

Gain Reverse Isolation

Input Return Loss Output Return Loss

Measured Performance – Small Signal
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Room Temperature: VDD = 3.3 V, VBIAS = 2, 2.5 and 3.3 V (IDD ≈ 20, 40 and 60 mA).

Gain Reverse Isolation

Input Return Loss Output Return Loss

Noise Figure

Measured Performance – Small Signal
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Nominal Bias: VDD = 3.3 V, VBIAS = 2.5 V (IDD ≈ 40 mA)

Gain vs Output Power at 24 GHz PAE vs Output Power at 24 GHz

Gain vs Output Power at 28 GHz PAE vs Output Power at 28 GHz

Gain vs Output Power at 31 GHz PAE vs Output Power at 31 GHz

Measured Performance – Large Signal

All  Plots must use a vector 
format (Paste->Special SVG or 
EMF)
All plots must have transparent 
background0
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Nominal Bias: VDD = 3.3 V, VBIAS = 2.5 V (IDDQ ≈ 40 mA)

IDD vs Output Power at 24 GHz IDD vs Output Power at 28 GHz

IDD vs Output Power at 31 GHz

Measured Performance – Large Signal

All  Plots must use a vector 
format (Paste->Special SVG or 
EMF)
All plots must have transparent 
background0
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Nominal Bias: VDD = 3.3 V, VBIAS = 2.5 V (IDDQ ≈ 40 mA)

Output P1dB Output P3dB

Gain at P1dB Gain at P3dB

PAE at P1dB PAE at P3dB

Measured Performance – Large Signal

All  Plots must use a vector 
format (Paste->Special SVG or 
EMF)
All plots must have transparent 
background
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Nominal Bias: VDD = 3.3 V, VBIAS = 2, 2.5 and 3.3 V (IDDQ ≈ 20, 40 and 60 mA)

Gain vs Output Power at 24 GHz PAE vs Output Power at 24 GHz

Gain vs Output Power at 28 GHz PAE vs Output Power at 28 GHz

Gain vs Output Power at 31 GHz PAE vs Output Power at 31 GHz

Measured Performance – Large Signal

All  Plots must use a vector 
format (Paste->Special SVG or 
EMF)
All plots must have transparent 
background0
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Nominal Bias: VDD = 3.3 V, VBIAS = 2, 2.5 and 3.3 V (IDDQ ≈ 20, 40 and 60 mA)

IDD vs Output Power at 24 GHz IDD vs Output Power at 28 GHz

IDD vs Output Power at 31 GHz

Measured Performance – Large Signal

All  Plots must use a vector 
format (Paste->Special SVG or 
EMF)
All plots must have transparent 
background0
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Room temperature: VDD = 3.3 V, VBIAS = 2, 2.5 and 3.3 V (IDDQ ≈ 20, 40 and 60 mA).

Output P1dB Output P3dB

Gain at P1dB Gain at P3dB

PAE at P1dB PAE at P3dB

Measured Performance – Large Signal

All  Plots must use a vector 
format (Paste->Special SVG or 
EMF)
All plots must have transparent 
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Room tempearture: VDD = 3.3 and 4 V, VBIAS = 2.5 V (IDDQ ≈ 40 mA)

Gain vs Output Power at 24 GHz PAE vs Output Power at 24 GHz

Gain vs Output Power at 28 GHz PAE vs Output Power at 28 GHz

Gain vs Output Power at 31 GHz PAE vs Output Power at 31 GHz

Measured Performance – Large Signal

All  Plots must use a vector 
format (Paste->Special SVG or 
EMF)
All plots must have transparent 
background
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Room tempearture: VDD = 3.3 and 4 V, VBIAS = 2.5 V (IDDQ ≈ 40 mA)

IDD vs Output Power at 24 GHz IDD vs Output Power at 28 GHz

IDD vs Output Power at 31 GHz

Measured Performance – Large Signal

All  Plots must use a vector 
format (Paste->Special SVG or 
EMF)
All plots must have transparent 
background0
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Room tempearture: VDD = 3.3 and 4 V, VBIAS = 2.5 V (IDDQ ≈ 40 mA)

Output P1dB Output P3dB

Gain at P1dB Gain at P3dB

PAE at P1dB PAE at P3dB

Measured Performance – Large Signal

All  Plots must use a vector 
format (Paste->Special SVG or 
EMF)
All plots must have transparent 
background
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Room tempearture: VDD = 3.3 V, VBIAS = 2.0, 2.5 and 3 V (IDDQ ≈ 20, 40 and 60mA), ∆F = 10 MHz

OIP3 versus POUT/tone at 24 GHz OIP3 versus POUT/tone at 28 GHz

OIP3 versus POUT/tone at 31 GHz OIP3 at POUT/tone = +5 dBm

Measured Performance – Linearity

All  Plots must use a vector 
format (Paste->Special SVG or 
EMF)
All plots must have transparent 
background0
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Biasing

ARF1201Q2 has two biasing methods. The first is VDD and VBIAS which can be biased with separate power supplies.  
By altering VBIAS the current of VDD will change the performance. The second method ties VBIAS to  VDD via a resistor. 
The value of the resistor determines the current of the device and some resistor and current values are provided in 
the evaluation board section.  This method enables the ARF1201Q2 to be biased by a single supply. 

Additionally, while the exact bypass network will be customer specific, we recommend as a minimum to have a 100 
pF capacitor and 10 nF capacitor on both the VDD and VBIAS lines. 

The Altum RF evaluation board ships with pads for biasing via a resistor but typically this isn’t populated. 

Application Schematic

Explain minimum bias 
requirements. This may be 
different to evaluation board. 
For instance if a part can be 
biased by one side only

Check Data design guidelines 
for schematic export tips.

Individual Biasing of VDD and VBIAS

Biasing through resistor

https://www.altumrf.com/
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Bill of Materials Evaluation Board Layout

Evaluation Board Schematic

J2 Pin Description

3 VBIAS

7 VDD

1,5 Unconnected

9,11 Thermistor (optional)

2,4,6,8,10,12 Ground

Description Reference Designator Quantity

ARF1201Q2 U1 1

10 nF 0603 
Capacitor

C1,C4 2

100 pF 0402 
Capacitor

C2,C3 2

820 Ω 0603 
Resistor (optional)

R1 1

12 pin Samtec 
TSM-106-01-F-DH-

P

J2 1

Southwest 
Microwave 2.92mm 

1092-01A-6 or 
equivalent

J1,J3 2

Recommended land-pattern and sample board 
layout for 254 µm thick RO4350B are available on 
request. 
Contact Altum RF Application Support for further 
information. 

Evaluation board Schematic 
should be in black on white.
Convert in inkscape or kicad 
(NOT in Powerpoint)

Set white background to 
transparent
Picture Format->Color-> Set 
Transparent color

Mark components that are not 
populated as DNP

5.   VBIAS can be supplied externally, or can be generated using the resistor R1 between the VDD rail and the VBIAS pin.

Bias Control5

VDD (V) IDD (mA) VBIAS (V) R1 (Ω)

3.3 60 3.3 0

3.3 40 2.5 820

3.3 20 1.9 2.2k

4.0 85 4.0 0

4.0 65 3.3 560

4.0 40 2.5 1.5k

https://www.altumrf.com/
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1. Bias Turn-on Sequence

VDD and VBIAS can be safely applied in any order, or simultaneously. 

The part has internal bias regulation. VBIAS can be supplied externally or can be generated using the resistor R1. 
Refer to Bias Control table for suggested operating bias condition.

The part can be turned off by applying 0 V to VBIAS or to VDD.

2. Reflow Information

MSL level 1 as per IPC/JEDEC J-STD-020E.

Application Notes

Delete if not applicable
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Outline Drawing

All dimensions are in millimeters.
Package leads and exposed pad are plated with NiPdAu.

Set white background to 
transparent
Picture Format->Color-> Set 
Transparent color

Package Information

    

    

    

 

 

 

 

   

   

  

       

          

YYWW is the date code

XXXX is the lot code

1201 is the part number
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Part Number Delivery Format Quantity

ARF1201Q2-TR500 Tape and Reel 500 pcs

ARF1201Q2-TR2500 Tape and Reel 2500 pcs

Export from The Netherlands/EU, no licence.

For further information please visit www.altumrf.com or contact us directly at  sales@altumrf.com.

Ordering Information

Document Information
Information provided by Altum RF is believed to be accurate and reliable. However, no responsibility is assumed by Altum RF for its use, nor for any 
infringements of patents or other rights of third parties that may result from its use. All information contained herein is subject to change without 
notice. Customers should obtain and verify the latest relevant information before placing orders. The information contained herein or any use of 
such information does not grant, explicitly or implicitly, to any party any patent rights, licenses, or any other intellectual property rights, whether 
with regard to such information itself or anything described by such information.

Advance: Expected performance based on feasibility analysis, simulations or measured data. All content is subject to change.
Preliminary: Measured performance based on prototype parts. Specifications including maximum and minimum values are subject to change.
Final:  Guaranteed performance of qualified and production released part.

Document Template: ARFDOC-1897081980-202625 (Rev: 1.0)
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